MITSUBISHI

SW3NIW-A8GOTP Graphic Settings Software Package

Operating Manual (Startup Manual)

GRAPHIC OPERATION TERMINAL

800

Series

GOT
MEISEC

Mitsubishi Graphic Operation Terminal




Revisions
* The manual number is noted at the lower left of the back cover.

Print Date | *Manual Number - Revision
Sep., 1997 | IB (NA)-66791-A | First printing :
Dec., 1997 | 1B (NA)-66791-B |Addition|
Section 1.4

Oct.,, 2000 | IB (NA)-66791-C |Addition|

. Section 3.1

Jun., 2004 | IB (NA)-66791-D | |Partial correction|
About the Manuals

WARRANTY

Japanese Manual Version IB-68911-D

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent
licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial
property rights which may occur as a result of using the contents noted in this manual.

© 1997 Mitsubishi Electric Corporation



Introduction

Thank you for purchasing the Mitsubishi Graphic Operation Terminal.

Before using the equipment, please read this manual carefully to develop full familiarity with the functions and
performance of the graphic operation terminal you have purchased, so as to ensure correct use.

Please forward a copy of this manual to the end user.
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About the Manuals

The following product manuals are available. Please use this table as a reference to request the
appropriate manual as necessary.

Related Manuals

Manual No.

Manual Name (Model Code)

A870GOT Graphic Operation Terminal User's Manual 1B-66628
This describes the specifications and performance of the AB70GOT main module, as well as (1DMO050)
the hardware configuration, procedures for installing optional modules, operation in on-line

mode, error codes, and troubleshooting guidelines. (Sold separately)
A850GOT Graphic Operation Terminal User's Manual IB-66669
This describes the specifications and performance of the AB50GOT main module, as well (1DMO038)

as the hardware configuration, procedures for installing optional modules, operation in on-
line mode, error codes, and troubleshooting guidelines.

A852GOT Graphic Operation Terminal User's Manual IB-66767
This describes the specifications and performance of the A852GOT main module, as well (1DM042)
as the hardware configuration, procedures for installing optional modules, operation in off-
line mode, error codes, and troubleshooting guidelines. (Included in the AB52GOT)

AB53GOT Graphic Operation Terminal User’s Manual IB-66785
This describes the specifications and performance of the AB53GOT main module, as well (1DM044)
as the system configuration. {included in the A853GOT)

SW3NIW-ASGOTP Graphic Settings Software Package Operating Manual IB-66792

(Introductory Manual) (1DM177)

This manual is designed for the first-time user of the GOT. it describes how to create
monitor screens with the ABGOTP, how to send monitor data to the GOT, and what the

various screen displays mean. (Sold separately)
SW3NIW-ABGOTP Graphic Settings Software Package Operating Manual IB-66793-A
(Monitor Screen Creation Manual) (1DM176)

This describes procedures for creating monitor screens, monitor functions that can be
used with the GOT, procedures for setting the monitor functions, precautions to be ob-
served when creating monitor screens, and precautions to be observed when appropriat-

ing conventional GOT monitor data for use with the GOT. {Sold separately)
SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual IB-66794-A
(Data Transmission/Debugging/Document Creation Manual) (1DM175)

This manual describes the following items.
(1) Procedures for downloading project data to the GOT and uploading data from the GOT
(2) Procedures for installing the operating system in the A870GOT
(3) Procedures for using the ABGOTP as a virtual PC and for debugging the GOT
(4) Procedures for outputting created monitor data as a completed document
(Sold separately)




Manual No.

Manual Name (Model Code)

GOT800 Series Operating Manual IB-66796

(Expanded Functions Manual) (1DM181)
This manual describes the operation procedures for using system monitor functions, monitor
functions for special function modules, and the dedicated monitor screens used with the
circuit monitor functions. (Sold separately)

SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual IB-66795

(Report Functions Manual) (1DM178)
Describes procedures to draw grid lines, set and edit report data using the report function.
(Sold separately)

Other's Programmable Controller - Bar-Code Connection System Manual 1B-66797

This describes the system configurations and setting method when GOT is connected to (1DM143)

other's programmable controller - bar-code. -
{Sold separately)
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1. Overview MELSEC GOT

1. Overview

This manual describes the SW3NIW-A8GOTP system configuration, the procedures for installing
the system, the screen configuration, and the basic operations involving dialog boxes.

1.1 Configuration of the Manual

l This manual consists of eight chapters, which mainly describe startup procedures and
the names of the various screens, as well as basic operations involving dialog boxes.

Chapter 1

Describes the configuration of the manual.

Chapter 2

Describes the system configuration when the
graphics software is used.

Chapter 3

Explains how to install the software pack-
age.

Chapter 4

Explains how to start up and exit the graph-
ics software.

Chapter 5

Explains the use of the keyboard and mouse
in the graphics software.

Chapter 6

Describes the configuration of screens in the
graphics software.

Chapter 7

Describes the operations used with the vari-
ous dialog boxes.

Chapter 8

Describes menu configurations.
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1.2 Structure and Guide to the Use of This Manual

When this graphics software is purchased, it comes with six operating manuals. Manuals are
categorized according to the purpose for which they are used. Please read the manual that corre-
sponds to your particular objective in order to become familiar with the operations and functions

of the software.

SW3NIW-AB8GOTP Operating Manual

¢ |nstall the graphics software in the com-
puter.

¢ Start up the graphics software.

* [earn fundamental information and basic
operations for the graphics software.

Startup manual

SW3NIW-ABGOTP

Personal
computer

Operating

Graphics
software

Clock display

erations.

¢ Create simple graphics, monitor using the
GOT, and learn the flow of a series of op-

SW3NIW-A8GOTP
Operating

Introductory
manual i

¢ Actually create screens for monitoring us-
ing the GOT.
Drawing graphics
Sprite settings
* Edit the data which has been created.

SW3NIW-A8GOTP
Operating

Monitor screen |
creation manual

Line monitor
OComeyr t

port data.
Create ruled lines.
Set the report data.
Edit the report data.

* To perform report function, create the re-

SW3NIW-A8GOTP
Operating

Report
functions
manual
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¢ |nstall the OS program and communica-
tions driver in the GOT.

¢ Download created graphics to the GOT.

¢ Debug graphics between the computer
and GOT.

Create data documents.

e Monitor circuits.

s Monitor the system.
¢ Monitor the special module.

Each of GOT User's Manual

GOT800 Series
Operating

Expanded
functions
manual

Special module monitor

SW3NIW-A8GOTP
Operating

Data transmission
Debugging

Document creation
manual

Circuit monitor

ml
YYIYY

System monitor

In

T3
|
(NRERE]

Install optional modules in the GOT.
Connect the GOT and PC CPU.

Find out how to attach the GOT and its ex-
ternal dimensions.

® Select a model.

i
O

GOT
User's
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1.3 Abbreviations and Symbols Used in This Manual

Abbreviation

Contents

Graphics software

This refers to the SWZNIW-A8GOTP.

Computer This refers to the peripheral device in which the graphics software
has been installed.
A870GOT This refers to the AB70GOT Graphic Operation Terminal
A85[] This refers to the AB50GOT/A851GOT/A852GOT/A853GOT.
GOT This refers to the A870GOT/A850GOT/A851GOT/A852GOT/
A853GOT.
Symbol Contents
| This indicates a command on a menu.
g This is the icon for the Tool Bar 1.
[ )| This indicates a displayed dialog box.
< > This indicates an item in a dialog box for which a setting can be entered.

This indicates a dialog box command button.

These are keys on the personal computer keyboard.

' This indicates an item which can be referenced in this manual.
@Mousé This indicates an operation done using the mouse.
@Keyhoérd This indicates an operation done using the keyboard.
POINT This indicates that the information is particularly important.

)

This indicates the tab name for a dialog box.
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1.4 Product Configuration

Please check to make sure that the following products have been included with the equipment
you have purchased.

* SW3NIW-GOT800PSET

Floppy disks: 11
Manuals: 7

19 a

Software configuration

Graphics software SW3NIW-ABGOTP : 6 disks

System program SW3NIW-ABSYSP : 3 disks

Special module monitor data SW3NIW-AB8GMDP : 2 disks (SW3NIW-A8GMDP 1/2 is for
Japanese mode)

Report
Introductory Monitor screen functions
manual Startup manual creation manual manual Debugging manual

Other's program-

mable controlier -
Expanded bar-code connection

functions manual system manual
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2. System Configuration

2.1 System Configuration When Using the SW2NIW-A8GOTP

Windows computer

—

1.1 C3

L Graphics software
System program
Special module
Monitor data
(SW3NIW-GOTS00PSET)

Main module
Main memory
Hard disk
CRT

Mouse

: Personal computer which can run the Microsoft Windows Ver. 3.1
1 4 MB min. required (8 MB or more recommended)
: Available memory of at least 10 MB required in order to install program

: Any CRT which can be connected to the main module and with which the

Japanese version of Microsoft Windows Ver. 3.1 can be used

1 Any mouse which can be used with a Windows computer

* Windows 3.1, Windows 95 is a trademark of Microsoft Corporation (U.S.).



2. System Configuration MELSEC GOT

2.2 Describes the Operation with Windows 95

The graphics software runs normally on Windows 95.

However, do not switch the program, file, or window using the task bar displayed at the bottom of
the desktop when booting the graphics software.

When booting the graphics software, switching windows using the task bar may cause the data in
the currently open dialog box to be deleted.

We recommend setting the task bar to NOT DISPLAY when using the graphics software (this
automatically hides the task bar).
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3. Installing the Software Package

3.1 Installing the GOT8S00PSET

Describe the way to install GOT800PSET.

Turn on the power supply to the computer.

J

Start up MS-Windows Ver. 3.1 or Windows 95.

J

Insert the floppy disk in the drive of the SW3NIW-AS8GOTP 1/6.
Check the drive into which the disk has been inserted.

v

Excute [Set up-exe] on the floppy disk.

y

After setting (O to (&) on the screen below, click on| Install |.
‘The installation process begins.

[ Screen to be displayed ] ®

[==] Setup wil place SWINIW-GOTBOOPSET into the{following
directories, which it wil create on your hard disk.
If you want to install SW3INIW-GOTS00PSET in different

directories andfor drives, type the name of the flirectories.

X SWINIW-ABGOTP {Draw , Regjort) — @

Install to: IE\ABGOTP I Browse

\
® 5 $W3INIW-ABSYSP {AB70/810GOT.ABS*GOT)

Install to; IC:\ABGOTH,OS | Browse

l Browse

o

install to: |C=leOTPkABGMD

@

POINT

Depending on the Windows settings, the displayed screen messages may be in English. if you
want to change them to Japanese, make the following settings, and then follow the proce-
dure above to install.

Item Settings
When using Windows 95 | Click “Control Panel” — “Regional Settings”, then select “Japanese”
When using Windows 3.1 | Click “Control Panel” — “International” — “Country”, then select “Japan.”

3-1
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[ Setting contents ]

=

Place an “X” mark in the check box of LISW3INW-ASGOTP, LISE3NIW-A8SYSP, or LISW3NIW-
ABGMDP.

(The check box of SW3NIW-ASGMDP does not need to be selected when the special function
module monitor function is not being used. )

0) ltem button

Set the item to set up and sample screen to install.

Graphic software is installed. ~ Graphic software for reports is installed.

Seleci item
Install tems I
l oK I
X A8GOTP{Draw) Report Editor

X Basic figure Library .
1 Set the library number where
Install to Library No. |50 ] the basic graphics fibrary will be

- installed.

® button

Click on , specify the installation destination password of the SW3NIW-ASGOTP,
SW3NIW-8YSP, or SW3NIW-ABGMDP.

Select the directory of the installation destination.

ﬁ

Files: Directories:
a8gotp.got +
autoexec.bat £ bat
autoexec.w4l 3 bin
autoexet.you Cancel
base0002.a8 % ;"""“
chgwin.exe 0S8
command.com - € hyper
command.w40 1 melsc
config.sys £ mwave
config.w40 : £ mwave_c
dosime.sys . €1 mwd
hardboot.com A £ mww 3
Space Availfable: Drives:
214,769,664 byte lc: [WINDOWSS5] A Select the drive of the installation
destination.
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@® | OS Select | button

Clicking on |OS Select|, select the GOT to use, OS program and communication driver to be
installed in the [ltem Select] dialog box.

Select the GOT to use.

Select tem

Please click left Button to move items from "Install’  ‘Not install’ to
'Not install’ { *Ins}ail'.

[ GOT Type
A870/810GOT X
Not install: Install:
Standard monitor 1]
ROM_BIOS |
-> System monitor Select the function which will be
<= |Sp- unit monitor installed or not by clicking
MELSEC-A Ladder monitor | |
MELSEC-FX Ladder 3

® {Module Select | button

Cliking on |Module Select|, select the special function module monitor data to be installed in
the [ltem Select] dialog box.

Select Item

* Please. click left button to move items from ‘Install' 7 *Not install’ to
'Not install' { "Install’.

Not install: install:

A62DA-S1

A1S62DA

AG16DAV , AG16DAI
A1S68DAY , ATS68DA!

AGBAD Select the function which will be

AGBADN - installed or not by clicking
A1S68AD . <

AB4AD
A616AD
A1S64AD
AG16TD

[

«f
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4. Starting Up the Graphics Software

4.1 Booting the SW3NIW-AS8GOTP

Turn on the power supply to the computer.

y

Start up MS-Windows Ver. 3.1.

J

Move the cursor to the SW3NIW-A8GOTP icon and click on it.
B comw M

*

*|

The graphics software program is booted.

=

ABGOTP ME
Project{P] EditfE] Draw[D] Communication{C)] Common{O] Screen{S]) 2
o| s | /|7|olalol |ala] | h] |4 |e|®] ww] (&) |«]-
L:| — |&1—1|2 D #| Pattern:| None | ¥ D %{Cursor:| 16/ & 100% | &
[
. _ N
Please select figures or sprites. ﬁ No title ] X=249, Y= 55

4.2 Exiting the Graphics Software
@Mouse Exiting from the Project menu

1. Move the cursor to the Project menu and click on it.
2. Move the cursor to ] and click on it.

I Exiting from the contro! box in the application window

1. Move the cursor to the control box in the application window and click on it.

2. Move the cursor to Close[ and click on it.

4-1
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5. Basic Operations and Text Input
with the Mouse and Keyboard

This chapter explains the use of the mouse and keyboard in the graphics software.

5.1 Using the Mouse and Keyboard
Mouse operations

Click Click the mouse button once and immediately release it.
Double-click Click the mouse button twice in rapid succession.
Drag Hold down the mouse button and move the mouse.

5.2 Short-cut Keys Using [Ctri]

Key Function Content

+Z) Undo | Same operation as the [Undo || command on the Edit menu

Cut Same operation as the ] command on the Edit menu

Copy Same operation as the Copi[ command on the Edit menu

+ Paste Same operation as the | command on the Edit menu

New Same operation as the | command on the Project menu

Open | Same operation as the [Open|| command on the Project menu
[Cr]+(P] | Print | Same operation as the[Print]] command on the Project menu
+ - Save Same operation as the | command on the Project menu
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5.3 Access Keys

items on the various menu titles are followed by initial letters which can be used to select menu
items from the keyboard, without having to use the mouse.

| Project(P) Edit(E) Draw(D) Communication(C) Common(Q) Screen{S) 2 |
Menu bar access key
Entering “P" displays the drop-down menu under the Project menu.
Edit(E) Draw(D) Communication(C) Common{Q) Screen(S) 2 |
Open(0)... Ctrl+0
Close{C) —
Save(S) Ctrl+S
Save As(A)...
Import File(D) »
Print(P)... Ctrl+P
Option(T) ’
Exit(X) Alt+F4

Drop-down menu access key

Entering “C” closes the screen window.
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6. Learning the Screen Configuration

The screen for the graphics software is configured as shown below.
Application window maximum
display button

Application window control menu box Application window title bar

Application window icon button

ABGOTP
Menu bar Project{P] EditfE} Draw(D] Communication{C] Commeon[0] Screen{S] 2
Tool bar 1 o| |se| |/ |r|Tlalo]la]alin] |4 [e=le] [w]a] (B [«]-
Tool bar 2 L:[ — |#] —1]#][O|*|Patten:| None |&| []|%|Cursor:| 15| 2 mnz[:l

v | a{— Screen window
maximum display
button

Screen window = B
control menu

box

+*

. Screen window icon

Screen window button

title bar

$4t-— Scroll bar arrow

Please select figures or sprites. || No title ] IX=249, Y=55

[ |

Status bar
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6.1 Title Bar

@Mouse

This is where the title of the window is displayed. The title bar can be moved anywhere on the
screen by placing the cursor on it and dragging it.

There are two title bars in the graphics software: one for the application window, and one for the
screen window.

Also, the screen window is divided into two parts, a base screen window and a window screen
window, each with its own title bar.

Application window title bar

Screen window title bar

1. Base screen window title bar

The screen can be displayed in its maximum size by placing the cursor on the title bar and double-
clicking on it. If the maximum size is already displayed, double-clicking on the title bar or clicking
on the E] mark returns the display to the original size.

[T (Section 6.11, “Return to Original Size Button”)
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6.2 Menu Bar and Drop-down Menus

@Mouse

@Mouse

The names of menus that can be used with the graphics software are displayed on the menu bar.

[ Project(P) Edit(E) DrawiD) Communication(C) Common{Q) Screen(S) 2

]

Moving the cursor to the menu to be selected and clicking on it displays the pull-down menu.

Project(P) Edit(E)

Draw({D) Commumca’non(Q) Common(Q) Screen(S) 2

New(N) Ctrl+N IAlé] A I&l% @| |ta|za| .

Open(0Q)... Ctrl+0 {1 Sttorm] N ARINE 1% 1ol 11005 e
Close(C) *| Patiern:| None |%® *! Cursor: $ % |&
Save(§) Ctrl+S

Save As{A)...

Import File(]) ’

Print{P)... Cirl+P

Option{I) »

Exit(X) Alt+F4

[Piease select figures or sprites. I[ No title | X=238, Y= 0

POINT

If a command has three dots after it (...), moving the cursor to that command and clicking on
it, or entering the access key, displays the dialog box where settings can be entered.

If there is an arrow () displayed to the right of a command on the menu, a command menu can
be displayed, as shown below.

Click on|Read Other Data ﬂ to display the sub-menu.

Project(P) Edit{) Draw(D) Communication{C) Common{Q) Screen{S) 2
New(N) Ctrl+N TAIM A lgf,]r% @| |ta|xg;| .

+
gﬁ;n((_g)) Cirl+0 +| Pattern:| None |¢{[] [#| Cursor:| 16 |2| | 100% |&
Save($) Chrl+S
Save AslA)...
Import File(D) Project(R)...
Print(P)... Chri+p | Picture(C)...

AGOTP DatalA)...

Option(D)
Exit(x) Alf+F4
Please select figures or sprites. |[ No fitle ] X=238, Y= 0
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6.3 ToolBar1

@Mouse

This is where items assigned on the menu bar are displayed as icons.

\/
O @ 0AFEOEOL O VBB ®® @

Names of icons

@ Panel kit Paint

@ Sprite @ Cursor (for graphics editing or sprite editing)
® Line @ Cut

@® Line Freeform @ Copy

(® Rectangle Paste

® Polygon @® Group

@ Circle @ Ungroup

Arc @ Preview

® Text Change the window

Move the cursor to the desired icon and click on it.

6.4 ToolBar2

The attributes of items assigned on the menu bar (lines, patterns, etc.) are displayed on this tool
bar.

L:| — {¢] —1 {2] L] |¢] Pattern:| None {#] [ ] |#f Cursor:| 16 [2] | 100% |2
@ @ ® ® ® ® @
@ Line type setting/change (& Pattern color setting/change
(@ Line width setting/change (® Setting of amount of cursor movement
® Line color setting/change (@ Expansion of screen window

® Pattern type setting/change

Moving the cursor to the down arrow E] and clicking on it opens the corresponding drop-down
menu for the selected item. Move the cursor to the attribute to be changed, and click on it.
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6.5 Status Bar

This is displayed at the bottom of the application window, and shows the current operation status,
a directory of any project data currently open, and the cursor coordinates.

Please select figures or sprites B:¥A8GOTP¥UC X= 0,Y=0

6.6 Scroll Bars

If the figure which has been drawn does not fit completely within the window, the scroll bars can
be used to change the area displayed and view other parts of the figure.

Horizontal scrolt bar

@Mouse Move the cursor to the scroll bar slider and drag it to the desired position, or click on the scroll bar
arrow to move the display.

@Keyboard 1. The [PageUp| and [PageDown| keys can be used to scroll the currently displayed screen upwards or
downwards. -

2. The [CTRL] + [PageUp| and [CTRL] + [PageDown| keys can be used to scroll the currently displayed
screen to the right or left.
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6.7 Control Menu Box

This is used to change the size of the window and move the window, to switch applications, and
to close the window.

In the graphics software, there are two control menu boxes: one for the application window, and
one for the screen window.

I Directory of commands in the application window control box

I—_ Control menu box

ABGOTP -~

Move
Size
Minimize
Maximize

Close Alt+F4
Switch To... Ctrl+Esc

@Mouse Move the cursor to the control menu box and click on it.
I Directory of commands in the screen window control box

[_ Control menu box

B-1 No title -

Mowve
Size |
Minimize
Magimize
Close ©  Ctrl+F4

Next Ctrl+Fb

@Mouse " Move the cursor to the control menu box and click on it.

POINT

Commands covered by a mask cannot be selected.
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6.8 Command Box

This displays a directory of sprites accessed using the icon on the title bar 1.

Lamp

Numerical Disp.|{ Ascii Disp.

Datalist Clock

Comment Alarm History

Alarm List Part Disp.

Part Move Panelmeter
Level Trend Chart
Line Chart Bar Chart

Numerical Inp. Ascii Inp.

Cursor Move Window Pos

@Mouse Move the cursor to [8P] icon and click on it. Then move the cursor to the desired command and
click on it to select it.
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6.9 Icon Buttons

Windows can be represented as icons for easy access. With the graphics software, there are two
buttons for this purpose: one for application window icons and one for screen window icons.

Application window Icon button

icon button
@Mouse Move the cursor to the Icon button and click on it. If the application window is represented by an
icon, it will look like this:
| Screen window icon button
lcon button
@Mouse Move the cursor to the lcon button and click on it. If the screen window is represented by an icon,

it will look like this:
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6.10 Maximum Display Button

The window size can be expanded to fill the entire screen. With the graphics software, there are
two buttons for this purpose: one for the application window, and one for the screen window.

| Application window Maximum Display button

Maximum Display button

Move the cursor to the Maximum Display button and click on it.

| Screen window Maximum Display button

Maximum Display button

Move the cursor to the Maximum Display button and click on it.
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6.11 Return to Original Size Button

if an application window or a screen window has been enlarged to the maximum display size or
has been represented as an icon, this button returns the window to its original size. With the
graphics software, there are two buttons for this purpose: one for the application window, and
one for the screen window.

| Application window Return to Original Size button

Return to Original Size button

@Mouse Move the cursor to the Return to Original Size button and click on it.

I Screen window Return to Original Size button

Project(P) Edit{E) Draw(D} Communa’rion() ommon(Q) Screen(S) 2

Return to Original Size button

2 ld

@Mouse Move the cursor to the Return to Original Size button and click on it.
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6.12 Changing the Window Size

The horizontal and/or vertical size of the window can be changed to any desired size. With the
graphics software, there are two buttons for this purpose: one for the application window, and
one for the screen window.

| Application window Change Window Size button
@Mouse Move the cursor to the Change Window Size button and click on it.

| Screen window Change Window Size button
@Mouse Move the cursor to the Change Window Size button and click on it.
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6.13 Switching Application Windows

With this function, a different application can be run without exiting the graphics software. The
procedure is outlined below.

@Mouse 1. Click on the control menu box in the application window.

2. Click on|{Switch To | . When the “Switch Application” dialog box is displayed, double-click on
the application to be run.

@Keyboard Press [ Alt }+[Tab] or [ Alt ]+[Esc ] to switch applications.

Example of application switching dialog box

B ks |

Ploglam Manager
PowerMan

Switch To End Task Cancel

Cascade Tile Amange lcons
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6.14 Base Screen Windows and Window Screen Windows

Images of base screen and window screen

) o

Mov‘e key
Close key: T
Touching the Close Sl To move a window
key on the window Win 6‘ ' screen, touch the
screen closes the Indow screen ! Move key, and then
screen. ! touch the place to
! which you want to
____________________ H move the screen.
Base screen
NITSUBISHI

6.14.1 Base Screen Windows

These are windows which are used to create the screen data displayed as the GOT base screen.
Up to 1,024 base screens can be displayed with the GOT, so 1,024 screens can be created with
the graphics software.

(1) AB70GOT

The sizes of the base screens are different with the STN/TFT and the EL models.

STN/TET model EL model for A870 GOT

400 dots
480 dots

T
Y

, 11 640 dots
: 640 dots '

(2) A8sLIGOT

The screen sizes of the L and STN models are the same.

240 dots

320 dots
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Message displayed on GOT and displayed on a base screen on the computer

Base screen

Up to 1,024 screens
can be created

2

MELSEC GOT

/- J
POINT
Up to 1,024 screens can be created, but the
number that can actually be created depends
on how much memory is available.
A . W W WA WAL
1111 S Y WO, WA}
“._ ““_ . Base screen
" r~
. ’d n Up to 1,024 screens
can be displayed
MITSUBISHI
—
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6.14.2 Window Screen Windows

These are windows used to create window screen data displayed as pop-up windows on a GOT
base screen. Up to 1,024 window screens can be displayed on the GOT, so up to 1,024 screens
can be created with the graphics software.

(1) AB70GOT

The screen size can be set in the following range.

Minimum size: 99 dots x 83 dots (Drawing graphics in the graphic software or
sprite function setting can be made in 96 dots x 64 dots.)

Maximum size: 446 dots x 247 dots {Drawing graphics in the graphic software or
sprite function setting can be made in 443 dots x 228 dots.)

Maximum: W446 x L247 dots

Initial value: W316 x L176 dots
Minimum: W96 x L64 dots

\j

_ Basic range: W640 x L480 (400 for ABGT-70GOT-EW/EB) dots

Setting range for width: Minimum 96 dots, default 316 dots, maximum 446 dots
(Settable in any dot units within this range)

Setting range for length: Minimum 64 dots, default 176 dots, maximum 247 dots
(Settable in any dot units within this range)

(2) ABSLIGOT |

128 dots

192 dots '
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MELSEC GOT

7. Learning Basic Dialog Box
Operations

71 Setting Dialog Boxes

The setting dialog boxes consist of command buttons, check boxes, radio buttons, spin boxes,
list boxes, text boxes, and tabs. Some of them are where operations are specified by entering

numerical values, and some are screen title setting dialog boxes.

[Numerical value display settings] dialog box

= Numerical Display

Tab

Spin box

List box
Radio button

~ Pasitian I’Size

x:l? B v:-o B | vl w [

| K |

~ Monitor device{5$]
[oFF | [Dev. |

Provious

" Display style
|Signed decimal ]tl Digits: Decimal point:

6 Left alignment @' Right alignment Ei] Disp. all digits

Default Color: l: Bhin :I_____l

{igtine on?

Check box

[Screen title settings] dialog box

Text box

Title:

[ ] Lok |
U
Detailed explanation:

o | *

No.: 1

Command button
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7.2 Setting the Various ltems

ltem Description

Command button Command buttons are those such as |OK| and | Cancel] , and are
clicked to execute the various items they represent.

Check box Items in these boxes are executed by clicking on the box to place a
check mark in it.

List box First the downward arrow [§] is clicked to display the selection list,
and then the desired item is selected by clicking on it.

Text box Characters are input from the keyboard.
If a text box is for numeric input, no other characters should be
entered in it. If anything other than a numeric value is input, all sub-
sequent characters input will be ignored.

Radio button items are selected by clicking on the circle.

Spin box To input a value directly, click on the box [ and then enter a
numeric value from the keyboard.

To change the value, click on the up and down arrows.

Tab To switch the displayed tab, click on the location where the set item
is displayed.
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7.3 Message Dialog Boxes

If an attempt is made to execute an operation and execution cannot be carried out, a message

dialog box is displayed, telling the user why the operation could not be carried out, and requesting
confirmation.

I If the user entered an inappropriate setting or did something incorrectly, the follow-
ing dialog box is displayed.

<Example>

When only one screen is opened,
the screen cannot be closed.

oK

@Mouse To close the dialog box, move the cursor to and click on it.

To move the dialog box, move the cursor to the menu bar and drag it to the desired position.

| If an incorrect setting has been entered for peripheral equipment, or a peripheral
unit is not ready for operation, the following dialog box is displayed.

<Example>

‘Cannot read drive a:.

@ Please verify the drive door is closed and that

the disk is formatted and free of errors.

Cancel

@Mouse To try the operation again, move the cursor to | Betry | and click on it.
To cancel the operation, move the cursor to and click on it.

To move the dialog box, move the cursor to the menu bar and drag it to the desired position.
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7.4 Information Dialog Boxes

When executing an operation, any items which require confirmation by the user or additional
instruction are displayed in a dialog box like that shown below.

<Example>

O Do you delete the panelkit of No. 12

Yes

@Mouse To go ahead and execute the operation, move the cursor to and click on it.
To cancel the operation, move the cursor to and click on it.

To move the dialog box, move the cursor to the menu bar and drag it to the desired position.

7.5 Critical Dialog Boxes

If a critical system or application error occurs, a dialog box like that shown below is displayed.

= Error Deleting File

Cannot delete CVABGOTPAWGOT.EXE: File in
use by Windows.

@Mouse To close the dialog box, move the cursor to {OK|and click on it.

To move the dialog box, move the cursor to the menu bar and drag it to the desired position.
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8. Menu Configuration

The commands found on the menu bar are explained here.

[ Project Il

I— Import File

— Project
~ Picture
— AGOTP Data

— G

— R

— Exit

— Edit Text
— Edit Vertex
— Object of Selection

— Select All

Figure and Sprite ..
roup
Group
Ungroup
otate/Flip
— Flip Vertical
— Flip Horizontal
— Rotate Left
lign
— Center

— Bottom ....cocveveenn.

—R

— Attribute

— Edit Sprite

— Stacking Order

Bring to Front
Send to Back

eplace Devices

Creates new project data.

Reads an already existing file.

Writes data to a file being edited.

Overwrites existing project data in a file being edited with the edited data.

Saves the file currently being edited under a different name and allows editing to
be continued.

Reads other project data into the project data being edited.

Pastes graphic data in the BMP format into the screen window.
Outputs setting data, graphic images, and other data to a printer file.
Outputs setting data, graphic images, and other data to a printer file.

Specification of the work area, settings for edit files at the time of startup, and
other settings are entered here.

Sets whether or not tool bars and the status bar are to be displayed.

Sets the communication port and communication speed.

Exits the ABGOTP.

Deletes the last change to the data and returns the data to the status it was in
before the last change was made.

Deletes graphics, text, and sprites and stores them on the Clipboard.

Stores the selected graphics, text and sprites on the Clipboard without deleting
them from the file.

Pastes graphics, text and sprites stored on the Clipboard.

Copies the selected graphics and sprites collectively, and pastes them into the
edit screen.

Changes the character attribute.

Changes the length of a continuous straight line, or the line around a polygon.

Selects only a figure for editing.
Selects only a sprite for editing.

. Selects the figure and sprite for which editing.

Selects all of the figures, text and sprites for editing.

Groups the selected figures or sprites.
Cancels the grouping of the selected figures or sprites.

Reverses the upper and lower sides of the selected figure.
Reverses the left and right sides of the selected figure.
Rotates the selected figure 90 degrees to the left.

Aligns the selected figures or sprites in the center.

Aligns the selected figures or sprites at the top.

Aligns the selected figures or sprites along the top, at even intervals.
Aligns the selected figures or sprites at the bottom.

Aligns the selected figures or sprites at the left.

Aligns the selected figures or sprites along the left, at even intervals.
Aligns the selected figures or sprites at the right.

Brings the selected figure or sprite to the front screen.
Sends the selected figure or sprite to the back screen.

Changes and specifies the attributes of a figure being drawn or a figure already
drawn.

Corrects, diverts, or deletes a sprite.
Changes all of the specified monitor devices to other devices.
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— Panelkit .........cccecveenrnne Reads, saves, and deletes panel kits.
— Part ........... e Saves parts displayed with the parts display function and parts movement display
function.
— Comment .......ccccernnee. Saves comments displayed with the comment display function and alarm list dis-
play function.
t— Draw Figure
= LiNe «ovververeeennrcenen, Draws a straight line.
— Line Freeform.......... Draws a continuous straight line.
— Rectangle .............. Draws a rectangle.
— Polygon .........c....... Draws a polygon.
= Circle ...ocvevveenen s Draws a circle or ellipse.
= AIG...ooiiveiiineereene Draws an arc or elliptical arc.
= Text oo Inputs a character.
—Paint ..........ccoeeiens Paints a polygon or closed area with a selected pattern.
— Data Display
— Numerical Display .. Sets the numeric display function.
I— Data List ................ Sets the data list display function.
[ Ascii Display ........... Sets the ASCII display function.
Clock ....covvveeinnennnn Sets the clock display function.
— Message Display
— Comment .............. Sets the comment display function.
—— Alarm History ......... Sets the alarm history display function.
— Alarm List............... Sets the alarm list display function.
— Animated Display.
I— Parts Display .......... Sets the parts display function.
— Parts Movement .... Sets the parts movement function.
—Lamp oo Sets the lamp display function.
— Panelmeter ............ Sets the panel display function.
— Graph
— Trend .cocvvnecennn, Sets the trend graph display function.
— Ling ..o Sets the polygonal graph display function.
FBar e, Sets the bar graph display function.
—Level.....oocveee Sets the level display function.
— Touch Key ....ccccocvveenne. Sets the touch switch function.
— Data input
— Numerical Input...... Sets the numerical input function.
— Ascii Input .............. Sets the ASCII input function.

Communication

— Cursor Info .............
— Window Position ...... e

— Download

Monitor Data..........
Special
Function Data ........

Sets the cursor information function.
Sets the position at which the window is displayed on the screen.

Downloads project data.

Downloads monitor data for the special module.

= Upload ......cccoocverennnnnn Uploads project data.

= Instalt

— OS . Installs the OS.

— ROM_BICS ............ Installs the ROM_BIOS.

= Memory ......coeeeeninnins Displays the contents of the built-in memory and clears the built-in memory.
—-Memory Card ............... Displays the contents of the memory card, and formats the memory card.
— Debug ..o Activates the on-line debugging function.
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Screen

Screen.....c.ccooeveen. Sets titles and detailed descriptions for base screens and window screens.
Project ........ccocee. Registers titles and 1D numbers for project data.
— Option

L- PC Communication ... Sets the high speed for communication.
— Scr. Switching Device ...... Sets the base and window monitor screen switching.

— Password ........cccoc....... Registers a password for project data.
— Hard Copy ...ocooveeeeivenen Sets the hard copy trigger.
— Operation Panel ............ Sets the operation panel.
— System Information........ Checks the device used to confirm GOT operation conditions with the PC CPU.
— Observe Status............. Sets the status monitoring function.
— Alarm History ............... Sets the alarm history display function (Common Setting).
L GOT TYPE .ovvevieevecrne Sets the GOT type for the screen data to be created.
PCTYPE wvecveevrcienne Sets the connection PC type.
Load....ccoveieviiiivinen, Opens the specified screen window in the application window.
— Clear.....ovenviiiccnnnn, Closes the specified screen window.
— Clearand Load ............. Closes the screen being edited and opens a different screen.
= Store ..o Saves the screen being edited and allows editing to be continued.
- SOre AS oo Changes the number of the screen being edited.
— Scr. Utilize /Delete ........ Diverts/deletes the screen data in the project being edited.
— Preview
Image ......cccceeeeene Displays the contents set for the monitor screen as an image when the monitor
function is run.
Device .....c.ceceeveene Displays the name of the monitor device for the monitor function setting.
Image and Device .. Displays an image superimposed on a device disptay.
Canvas .......ccoeeenen. Displays whatever has been drawn.
Sprite ID ................ Displays the sprite ID number being set on the screen.
— Redisplay..........cccernerns Selected when a graphic drawn with several windows open at the same time in the
graphics software cannot be displayed properly.
— Cascade ..c....ccovevinennnen. Displays currently open screen windows as a superimposed display.
b= Title oo Displays all currently open screen windows in a series.
— List Open Screens ........ Activates screens among the currently open screen windows which are to be ed-
ited.

ADbOUL .o Displays the version of the graphics software currently installed.



WARRANTY

Please confirm the following product warranty details before starting use.

1. Gratis Warranty Term and Gratis Warranty Range
If any faults or defects (hereinafter "Failure) found to be the responsibility of Mitsubishi occurs during use of the product
within the gratis warranty term, the product shall be repaired at no cost via the dealer or Mitsubishi Service Company.
Note that if repairs are required at a site overseas, on a detached island or remote place, expenses to dispatch an
engineer shall be charged for.

[Gratis Warranty Term]
The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated
place.
Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and
the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair
parts shall not exceed the gratis warranty term before repairs.

[Gratis Warranty Range]

(1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc.,
which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels
on the product.

(2) Even within the gratis warranty term, repairs shall be charged for in the following cases.

1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused

by the user's hardware or software design.

2. Failure caused by unapproved modifications, etc., to the product by the user.

3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions
or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary
by industry standards, had been provided.

. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the
instruction manual had been correctly serviced or replaced.

. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force
majeure such as earthquakes, lightning, wind and water damage.

. Failure caused by reasons unpredictable by scientific technology standards at time of shlpment from Mitsubishi.

7. Any other failure found not to be the responsibility of Mitsubishi or the user.

(=225 ) I

2. Onerous repair term after discontinuation of production
(1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued.
Discontinuation of production shall be nofified with Mitsubishi Technical Bulletins, etc.
(2) Product supply (including repair parts) is not possible after production is discontinued.

3. Overseas service
Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA

Center may differ.

4. Exclusion of chance loss and secondary loss from warranty liability
Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to damages caused by any cause
found not to be the responsibility of Mitsubishi, chance losses, lost profits incurred to the user by Failures of Mitsubishi
products, damages and secondary damages caused from special reasons regardless of Mitsubishi's expectations,
compensation for accidents, and compensation for damages to products other than Mitsubishi products and other duties.

5. Changes in product specifications

The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. Product application

(1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will
not lead to a major accident even if any problem or fault should occur in the programmable logic controller device, and
that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.

(2) The Mitsubishi general-purpose programmable logic controller has been designed and manufactured for applications
in general industries, efc. Thus, applications in which the public could be affected such as in nuclear power plants and
other power plants operated by respective power companies, and applications in which a special quality assurance
system is required, such as for Railway companies or National Defense purposes shall be excluded from the
programmable logic controller applications.

Note that even with these applications, if the user approves that the application is to be limited and a special quality is
not required, appllcatlon shall be possible.

When considering use in aircraft, medical applications, railways, incineration and fuel devices, manned transport
devices, equipment for recreation and amusement, and safety devices, in which human life or assets could be greatly
affected and for which a particularly high reliability is required in terms of safety and control system, please consult
with Mitsubishi and discuss the required specifications.
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